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 Important Information

Warranty
The TPC-2106/2106T is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as 
evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective 
during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in 
materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments 
will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects 
during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any 
equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by 
warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In 
the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document 
without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National 
Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL 
INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING 
FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of 
the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence. Any action against 
National Instruments must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in 
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, malfunctions, or service 
failures caused by owner’s failure to follow the National Instruments installation, operation, or maintenance instructions; owner’s modification of the 
product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or other events outside 
reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

National Instruments respects the intellectual property of others, and we ask our users to do the same. NI software is protected by copyright and other 
intellectual property laws. Where NI software may be used to reproduce software or other materials belonging to others, you may use NI software only 
to reproduce materials that you may reproduce in accordance with the terms of any applicable license or other legal restriction.

Trademarks
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section 
on ni.com/legal for more information about National Instruments trademarks.

Other product and company names mentioned herein are trademarks or trade names of their respective companies.

Members of the National Instruments Alliance Partner Program are business entities independent from National Instruments and have no agency, 
partnership, or joint-venture relationship with National Instruments.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE 
COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, 
TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR 
ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER 
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF 
HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY 
UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, 
THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, 
INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS 
CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION 
DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT 
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY 
RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER 
NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT 
LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

Compliance with FCC/Canada Radio Frequency Interference 
Regulations

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC 
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) 
or Class B (for use in residential or commercial locations). All National Instruments (NI) products are FCC Class A products.

Depending on where it is operated, this Class A product could be subject to restrictions in the FCC rules. (In Canada, the 
Department of Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.) Digital 
electronics emit weak signals during normal operation that can affect radio, television, or other wireless products.

All Class A products display a simple warning statement of one paragraph in length regarding interference and undesired 
operation. The FCC rules have restrictions regarding the locations where FCC Class A products can be operated.

Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions 
in this manual and the CE marking Declaration of Conformity*, may cause interference to radio and television reception. 
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department 
of Communications (DOC). 

Changes or modifications not expressly approved by NI could void the user’s authority to operate the equipment under the 
FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user is required to correct the interference 
at their own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance with EU Directives
Users in the European Union (EU) should refer to the Declaration of Conformity (DoC) for information* pertaining to the 
CE marking. Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory compliance 
information. To obtain the DoC for this product, visit ni.com/certification, search by model number or product line, 
and click the appropriate link in the Certification column.

* The CE marking Declaration of Conformity contains important supplementary information and instructions for the user or 
installer.



Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 

avoid injury, data loss, or a system crash. When this symbol is marked on a 

product, refer to the Safety section of Appendix A, Specifications, for 

information about precautions to take.

When symbol is marked on a product, it denotes a warning advising you to 

take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be 

hot. Touching this component may result in bodily injury.

bold Bold text denotes items that you must select or click in the software, such 

as menu items and dialog box options. Bold text also denotes parameter 

names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 

to a key concept. Italic text also denotes text that is a placeholder for a word 

or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames, and extensions.

monospace bold Bold text in this font denotes the messages and responses that the computer 

automatically prints to the screen. This font also emphasizes lines of code 

that are different from the other examples.



© National Instruments Corporation vii TPC-2106/2106T User Manual

Contents

Chapter 1
General Information

Introduction....................................................................................................................1-1

I/O Ports .........................................................................................................................1-1

Storage ...........................................................................................................................1-2

Cleaning .........................................................................................................................1-2

Chapter 2
System Setup

Important Safety Information ........................................................................................2-1

Setup ..............................................................................................................................2-2

Touchscreen Calibration..................................................................................2-3

Panel Mounting..............................................................................................................2-4

Chapter 3
System Configuration

Display Settings .............................................................................................................3-1

Touchscreen Calibration ................................................................................................3-2

Beep Settings .................................................................................................................3-2

Chapter 4
Windows CE .NET

TPC Utilities ..................................................................................................................4-1

Soft Keyboard..................................................................................................4-1

TPC Configuration ..........................................................................................4-1

General ..............................................................................................4-2

Network.............................................................................................4-2

Watchdog ..........................................................................................4-2

Misc...................................................................................................4-2

Tools ................................................................................................................4-3

ActiveSync ........................................................................................4-3

Registry Editor ..................................................................................4-3

Registry Saver ...................................................................................4-3

Remote Display Application.............................................................4-4

NotepadPlus ......................................................................................4-4

TPC Configurator..............................................................................4-4

TPC Version Information..................................................................4-4



Contents

TPC-2106/2106T User Manual viii ni.com

Other Utilities.................................................................................................. 4-4

Bright.exe [Level]:............................................................................ 4-4

Buzzer.exe [frequency] [duration]:................................................... 4-4

Contrast.exe [Level]: ........................................................................ 4-5

RegSave.exe [-s]:.............................................................................. 4-5

Reboot.exe: ....................................................................................... 4-5

Screen.exe [on/off]: .......................................................................... 4-5

Iesample.exe [-n] [-f] [ip address/ folder name]:.............................. 4-5

Networking .................................................................................................................... 4-5

Networking Via Ethernet ................................................................................ 4-5

Networking Via the Serial Port ....................................................................... 4-6

ActiveSync Setup ............................................................................. 4-6

Networking via the USB Client Port............................................................... 4-7

Appendix A
Specifications

Appendix B
Watchdog Timer Programming

Appendix C
Fuse Replacement

Appendix D
Pin Assignments

Appendix E
Technical Support and Professional Services

Index



© National Instruments Corporation 1-1 TPC-2106/2106T User Manual

1
General Information

This chapter includes general information about the TPC-2106/2106T 

Human Machine Interface (HMI).

Introduction

The TPC-2106/2106T touch panel computer, a state-of-the-art RISC-based 

HMI, includes these key features:

• Fanless—Because the system uses a low-power processor, it does not 

need fans, which often are unreliable and cause dust to circulate inside 

the equipment.

• Bright display—The CSTN LCD features a 5.7 in. (5.6 in. for the 

TPC-2106T) display that meets industrial demands for clear interfaces.

• Powerful Communication Capability—The TPC-2106/2106T is 

a powerful I/O interface for easy communication with other devices. 

The I/O interface includes RS232 and RS485 serial, Ethernet, and 

USB ports.

• Windows CE Support—An optional Windows CE operating system 

specifically for the TPC-2106/2106T is available for Windows CE 

application program builders.

• JVM Support—The TPC-2106/2106T is powered by JVM, which is 

compatible with PersonalJava 1.2.

I/O Ports

The TPC-2106/2106T includes the following ports:

• Three serial ports: two RS232 (COM1, COM2) and one configurable 

as RS485 (COM4) or RS232 (COM3)

• One RJ-45 Ethernet port

• Two USB ports compliant with USB 1.1: one USB Host (Type A) and 

one USB Client (Type B)

• One CompactFlash 2.0 type I/II slot
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Figure 1-1 shows the I/O port arrangement.

Figure 1-1.  I/O Ports Arrangement

Storage

The TPC-2106/2106T includes two storage methods: an onboard 64 MB 

NAND flash and a CompactFlash card. The system boot sequence is:

• If no CompactFlash card is installed, the system automatically boots 

from the onboard NAND flash.

• If a CompactFlash card is installed, the system boots from the 

CompactFlash card.

Cleaning

If you need to clean the unit, use a soft, nonmetallic brush. Make sure that 

the unit is completely dry and free from contaminants before returning it to 

service.

1 COM3 (RS232)/COM4 (RS485)

2 LAN

3 USB

4 USB

5 COM2 (RS232)

6 COM1 (RS232)

5 4

1 2 3

6
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2
System Setup

This chapter includes setup information for the TPC-2106/2106T.

Important Safety Information

Before setting up the TPC-2106/2106T, read these safety instructions 

carefully.

Disconnect this equipment from any AC outlet before cleaning. Use a damp 

cloth. Do not use liquid or spray detergents for cleaning.

For plug-in equipment, the power outlet socket must be located near the 

equipment and must be easily accessible.

Keep this equipment away from excessive humidity.

Place this equipment on a reliable surface during installation. Dropping it 

or letting it fall may cause damage.

The openings on the enclosure are for air convection. Protect the equipment 

from overheating. Do not cover the openings. 

Make sure the power source voltage is correct before connecting the 

equipment to the power outlet.

Position the power cord so that it cannot be stepped on. Do not place 

anything over the power cord.

All cautions and warnings on the equipment should be noted.

If the equipment is not used for a long time, disconnect it from the power 

source to avoid damage by transient overvoltage.

Never pour any liquid into an opening. This may cause fire or electrical 

shock.

Never open the equipment. For safety reasons, only qualified service 

personnel should open the equipment.
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If one of the following situations arises, have service personnel check the 

equipment:

• The power cord or plug is damaged.

• Liquid has penetrated into the equipment.

• The equipment has been exposed to moisture.

• The equipment does not work well, or you cannot get it to work 

according to the user manual.

• The equipment has been dropped and damaged.

• The equipment has obvious signs of breakage.

Do not leave this equipment in an environment where the storage 

temperature may go below –20 °C (–4 °F) or above 70 °C (158 °F). Doing 

so could damage the equipment. The equipment should be in a controlled 

environment.

Caution There is a danger of explosion if the battery is incorrectly replaced. Replace the 

battery only with the same or equivalent type recommended by the manufacturer. Discard 

used batteries according to the manufacturer’s instructions.

Caution The protection this equipment provides may be impaired if it is used in a manner 

not described in this manual.

Setup

Follow these steps to set up the TPC-2106/2106T:

1. Unpack the TPC-2106/2106T. Be sure your kit includes the following 

items:

• The TPC-2106/2106T HMI

• Six panel mounting clamps

• Six panel mounting screws

• One 3-pin power connector and ground wire

• One HMI resource CD

• One 9-pin to 9-pin null modem cable

• One Microsoft Windows CE end user license agreement

• One 1.8 m USB client to USB host cable

• One 6 cm single DB-9 to dual DB-9 serial ports shunting cable

If any items are missing or damaged, contact National Instruments.
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2. Connect the power connector to 24 VDC power lines. Be sure 

to connect the positive, negative, and ground lines as shown in 

Figure 2-1. The power lines can be from either a power adapter or 

in-house power source.

Figure 2-1.  Power Connector

3. Connect the power connector to the power receptor on the 

TPC-2106/2106T. The power receptor pin assignment is shown 

in Figure 2-2.

Figure 2-2.  Power Receptor and Pin Assignment

4. Power on the system.

Touchscreen Calibration
The TPC-2106/2106T touchscreen should be correctly calibrated and ready 

to use when you power on the system. However, if the calibration is not 

correct or you want to choose custom calibration options, refer to the 

Touchscreen Calibration section of Chapter 3, System Configuration.

+ – GND

GND – +
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Panel Mounting

Follow these steps to mount the TPC-2106/2106T in a panel:

1. Be sure the adhesive waterproof gasket on the front bezel is in position.

2. Install the TPC-2106/2106T into the panel opening. (Refer to 

Appendix A, Specifications, for cutout dimensions.)

3. Hook the clamps included in the accessory pack to the holes around the 

four sides of the bezel.

4. Insert the screws included in the accessory pack into the clamps. To 

fasten the TPC-2106/2106T to the panel, tighten the screws so they 

push against the mounting panel.

Note The mounting panel thickness should be less than 6 mm (0.236 in.).
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3
System Configuration

This chapter explains how to configure the TPC-2106/2106T.

Display Settings

Use the display settings to control the backlight brightness and screen 

saver, which automatically turns off the screen when the TPC-2106/2106T 

is not in use for a designated time period. You can also select the system 

font size and rotate the screen.

Follow these steps to set the display properties:

1. Select Start»Settings»Control Panel»Display to access the Display 

Properties window.

2. To set the time to elapse before the backlight turns off, select the 

Backlight tab, click the Automatically turn off backlight while on 

external power checkbox, and select the time from the drop-down 

menu.

3. To set the LCD brightness, click the Advanced button to access the 

Advanced Backlight Options window. Move the slider or click + or – 

to adjust the LCD brightness and contrast. Click OK.

Follow these steps to select the system font size:

1. Select Start»Programs»Utilities»System Font Setting to access the 

System Font Setting window.

2. Select either Normal System Font Size or Small System Font Size.

3. Click Yes in the Warning window.

4. The system reboots and displays the font size you selected.

Follow these steps to rotate the screen:

1. Select Start»Settings»Control Panel»Screen Rotation to access the 

Screen Rotation window.

2. Select Not Rotated, 90 Degrees Counterclockwise, 180 Degrees 

Counterclockwise, or 270 Degrees Counterclockwise.

3. Click Apply. The screen appears rotated as you selected.
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Touchscreen Calibration

Follow these steps to calibrate the touchscreen:

1. Select Start»Settings»Control Panel»Stylus to access the Stylus 

Properties window.

There are two tabs in the Stylus Properties window: Double-Tap and 

Calibration. Use Double-Tap to record the time period between two 

taps when double-tapping in Windows CE. Use Calibration to calibrate 

the touchscreen.

2. Click the Calibration tab and click Recalibrate to calibrate the 

touchscreen. A cross appears on the screen in the following locations: 

center, upper left, lower left, lower right, and upper right. Use the 

stylus to tap the center of the cross until it moves to next location.

Beep Settings

In Windows CE .NET, you can set the TPC-2106/2106T to beep when you 

touch the touchscreen.

Follow these steps to enable or disable this function:

1. Select Start»Settings»Control Panel»Volume & Sounds to access 

the Volume and Sounds Properties window.

2. Use the controls in the Volume tab to set the volume and enable or 

disable the beep for various events and inputs.
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4
Windows CE .NET

The TPC-2106/2106T is designed for Windows CE. Windows CE is a 

compact operating system that occupies less storage space and uses fewer 

system resources than other operating systems. Its modular nature allows 

you to choose functions useful for a specific application. This reduces 

required system resources and boot time. This feature is important in 

industrial automation and operator interface terminals, because downtime 

is minimized. Also, the small storage space required allows installation on 

a reliable solid-state disk.

Note The TPC-2106/2106T includes the English version of Windows CE by default. 

Contact National Instruments for local language support.

Note The TPC-2106/2106T supports Remote Desktop Connection in Windows CE, but 

the maximum resolution supported is only 320 × 240.

TPC Utilities

Windows CE .NET on the TPC-2106/2106T includes several useful 

utilities.

Soft Keyboard
The TPC-2106/2106T is designed for small operator interfaces. Because it 

is inconvenient to attach a keyboard to such a small device, Windows CE 

.NET on the TPC-2106/2106T includes a soft keyboard. On boot, a small 

keyboard icon appears in the status bar. Tap this icon with the stylus to 

activate or hide the soft keyboard.

TPC Configuration
The TPC-2106/2106T includes an integrated utility to configure the basic 

device settings. To access the utility, click the TPC Configurator icon 

on the desktop. Navigate the configuration by tapping the four page tabs: 

General, Network, Watchdog, and Misc.
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General
The General page displays basic system information. There are two main 

parts: System and Disk & Memory. System shows the OS image version 

and CPU type. Disk & Memory includes total capacity, usage, and 

currently available capacity of the disk and memory.

Network
The Network page displays information about the active network adapter. 

Click Renew to release the current IP and retrieve a new IP. Click Ping to 

ping a specified IP address to test the connection.

Click Advanced for more detailed IP information, including the default 

gateway, DHCP server, primary WINS server, and DNS server addresses.

Watchdog
Using the watchdog function, the device automatically resets if a program 

does not respond in time. This prevents system crashes and hangs from 

stopping your critical applications, as the watchdog automatically restarts 

the machine when required.

Use the Watchdog tab to set the response time, which is the period that the 

watchdog waits for a response.

The response time is in effect only when you select a time span and enable 

the watchdog. When you enable the watchdog and click the Test button, 

the no resetting signal is sent to the watchdog hardware periodically. The 

watchdog assumes the machine is deadlocked and reboots it after 

the watchdog response time. If the machine reboots as expected after the 

watchdog response time, the watchdog is working properly.

Misc
The Misc tab includes the following functions:

Caution Do not enter the CompactFlash folder name in the CF Disk Name text box 

directly. Renaming the CompactFlash folder to a name not on the list causes irreversible 

problems with application program settings.

• Use Startup Programs to set the startup programs without editing. 

The programs listed under Startup Programs are automatically 

executed after the system has successfully booted. Click Add to add 

a file to the startup. Click Delete to remove a file from the startup.
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Note Do not try to insert a nonexecutable file into the startup program.

• Use Reboot to reboot the TPC-2106/2106T.

There are two additional ways to reboot the system: clicking the 

machine icon in the status bar and executing the reboot.exe 

command through a command line program.

• Use the Registry options to save and view registry information. Click 

Save to save the registry to a solid state disk. Click View to view, edit, 

create, or delete registry information. You also can back up or restore 

the registry setting by clicking Backup or Restore.

Note You cannot back up and restore over different image versions.

• Use Web Server Root to enter the web server root path. The root path 

takes effect only after rebooting the machine.

• Use Ftp Server Root to enter the FTP server root path. The root path 

takes effect only after rebooting the machine.

Tools
Select Start»Programs»Utilities to access the following tools.

Note For best results when accessing these tools, click the arrow to the right of the 

Utilities menu to avoid accidentally selecting a submenu item.

ActiveSync
ActiveSync synchronizes data and monitors the connection between the 

TPC-2106/2106T and host computer. By default, ActiveSync executes 

automatically when you use it to establish a connection to a target device.

Registry Editor
Use Registry Editor to view, edit, enter, delete, or save registry data.

Registry Saver
Use Registry Saver to save the system registry. In a command line 

environment, you can execute Registry Saver using regsave.exe or 

regsave.exe –s for the silence mode.
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Remote Display Application
Remote Display Application displays a Windows CE device screen on a 

remote desktop. It works with the Windows CE Remote Display Host 

application.

Because the connection is over the network, the host machine and 

TPC-2106/2106T network functions must work properly. You must execute 

Remote Display Host (cerhost.exe) on a remote host desktop. Also, you 

must run Remote Display Application on the TPC-2106/2106T. In the CE 

Remote Display window, click Connect and enter the hostname or IP 

address.

After successfully establishing the connection, you can see the 

TPC-2106/2106T display and control it from the host machine.

NotepadPlus
NotepadPlus is a text editor.

TPC Configurator
TPC Configurator is an integrated utility for configuring the basic 

TPC-2106/2106T settings. For more information, refer to TPC 

Configuration.

TPC Version Information
TPC Version Information shows the OS version information.

Other Utilities
The following utilities are command line-executed programs without 

graphical user interfaces. To execute these utilities, type the command 

names and parameters as shown below.

Bright.exe [Level]:
Sets the display brightness level. The parameters are 1 to 10.

Buzzer.exe [frequency] [duration]:
Plays a beep. Use parameters to set the frequency in Hertz and duration in 

milliseconds. If you do not use parameters, the default frequency is 350 Hz 

and default duration is 30 ms.
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Contrast.exe [Level]:
Sets the display contrast. The parameters are 1 to 10.

RegSave.exe [-s]:
Saves the registry settings. If you use RegSave.exe –s, no message box 

is displayed whether you are successful or fail.

Reboot.exe:
Saves the registry settings and reboots the TPC-2106/2106T.

Screen.exe [on/off]:
Turns the display on/off. Use Screen.exe on to turn on and Screen.exe 

off to turn off the display.

Iesample.exe [-n] [-f] [ip address/ folder name]:
Launches Internet Explorer. Use Iesample.exe -n to close the scroll bar. 

Use Iesamples.exe -f to activate the full screen. The parameters can 

be blank.

Networking

Networking Via Ethernet
Follow these steps to configure the TPC-2106/2106T Ethernet port:

Note Be sure you are connected to a LAN before booting the system.

Note The data transfer buffer size per package via Ethernet is about 20,000.

1. Select Start»Settings»Network and Dial-up Connections.

2. A window displaying all available connections appears. Double-click 

the icon for the connection you want to configure.

3. Select the IP Address tab and select Obtain an IP address via 

DHCP.

4. Select the Name Servers tab and enter the server addresses.

5. Select Start»Run. Enter regsave to save the registry settings to a 

storage card.
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Networking Via the Serial Port
This section explains how to set up the connection between the 

TPC-2106/2106T and a host PC via ActiveSync.

ActiveSync Setup
Follow these steps to set up ActiveSync:

1. Insert the TPC series support CD into the host PC CD-ROM.

2. Install the TPC software development kit for eVC++.

3. Install ActiveSync.

4. Connect the host computer and TPC with a null modem cable 

(included in the kit). Make sure the connection is solid on both RS232 

serial ports.

5. Set up the TPC-2106/2106T and host communication environments as 

described below.

Setting Up the TPC-2106/2106T Communication Environment

Note Before completing this section, change to the small system font size. Go to Start»

Programs»Utilities»System Font Setting. Click Small System Font Size. Click OK. 

A confirmation appears, saying This will change the system font size and 

reboot! Are you sure?. Click Yes.

Follow these steps to set up the TPC-2106/2106T communication 

environment:

1. To configure COM1 on the TPC-2106/2106T, select Start»Settings»

Control Panel.

2. Double-click the PC Connection icon.

3. Click Change to select the COM port.

4. In the Change Connection window, select Serial1.

5. Click Enter (the return arrow symbol) on the soft keyboard to confirm 

the change.

6. The PC Connection Properties window should display Serial1 in the 

Connect using: field.
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Setting Up the Host Communication Environment

Follow these steps to set up the host communication environment:

1. Double-click the ActiveSync icon on the host computer.

2. In the Microsoft ActiveSync window, select File»Connection 

Settings.

3. In the Connection Settings window, select Show status icon in 

taskbar, Allow USB connections, Allow connections to one of the 

following: (select COM1), and Open ActiveSync when my device 

connects. Also, select Automatic in the This computer is connected 

to: list.

4. Click Get Connected. The Get Connected window appears. Do not 

click Next at this time.

5. On the TPC-2106/2106T, select Start»Run. Enter \Windows\ 

repllog.exe and click OK.

6. In the Get Connected window on the host computer, click Next.

When the TPC and the host PC are connected, the Connected to My 

Connection window appears.

7. The New Partnership window appears on the host computer. Select No 

and click Next.

8. Click Explore in the Microsoft ActiveSync window. The Mobile 

Device window appears, displaying the TPC-2106/2106T file 

resources and information. For example, you could click My 

Documents to see documents on the TPC-2106/2106T.

Networking via the USB Client Port
In addition to connecting via a null modem cable as described in the 

previous section, you can also connect via the client USB port. To do this, 

you must install ActiveSync on the host computer. Then use a USB cable 

to connect the client and host USB ports. Be sure the TPC-2106/2106T PC 

connection setting is USB Socket Default (the default setting). Then follow 

the steps above to connect the TPC-2106/2106T and host automatically.
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A
Specifications

This appendix lists the TPC-2106/2106T system specifications.

Physical
Weight .................................................... 0.8 kg

Cutout dimensions.................................. 188 × 141 mm (suggested)
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Dimensions

System Kernel
CPU ........................................................Intel XScale PXA 270, 416 MHz

VGA........................................................CPU built-in

DRAM ....................................................Built-in 64 MB SDRAM

Storage memory......................................64 MB onboard NAND flash

187.84

[7.40]

148 [5.83]

140.84 [5.54]

195

[7.68]

44.4

[1.75]
6.0

[0.24]
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Ethernet .................................................. SMSC9115 10/100Base-T 

Ethernet controller; IEEE 802.3u 

protocol compatible

Watchdog timer...................................... Intel XScale PXA watchdog 

timer; 2, 5, 10, 15, 30, 40 s 

timeout period option

CompactFlash......................................... CompactFlash type I/II

LCD

Touchscreen
Touch type.............................................. Resistive

Base glass construction .......................... Tempered glass

Resolution .............................................. Continuous

Light transmission.................................. 75% typical

TPC-2106 TPC-2016T

Display type Color STN LCD Color TFT LCD

Size (diagonal) 5.7 in. 5.6 in.

Maximum resolution 320 × 240 (QVGA) 320 × 240 (QVGA)

Maximum colors 4096 256k

Pixel pitch 

(W × H, mm)

0.12 × 0.36 —

Viewing angle 100° 100°

Luminance (cd/m2) 400 500

Contrast ratio 55 400

Operating 

temperature

0 to 50 °C (ambient) 0 to 50 °C (ambient)

Control Contrast adjustable N/A

Backlight 1 CCFL 1 CCFL

Backlight MTBF 75,000 h 30,000 h
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Controller................................................DMC9000

Power rating............................................5 VDC

Software driver .......................................Windows CE (embedded)

Durability................................................10 million times with an 8 mm 

diameter silicone rubber finger

Note No pointer/cursor appears when using the touchscreen. The cursor appears only 

when closing or minimizing the window.

Power
Input voltage ...........................................18 to 32 VDC (the fuse becomes 

an open circuit if input level 

exceeds 33 VDC)

Maximum current ...................................3.15 A (typical 24 VDC at 0.8 A)

Fuse
Rating......................................................T3.15A 250 V

Size .........................................................5 × 20 mm

Note When replacing the fuse, use only a fuse of the same type and rating.

Note The fuse is set to break if the input voltage exceeds 33 VDC.

Environment
Operating temperature ............................0 to 50 °C

Storage temperature ................................–20 to 70 °C

Humidity .................................................10 to 95% @ 40 °C relative 

humidity (noncondensing)

Vibration .................................................10 to 18 Hz @ 1.5 mm 

peak-to-peak displacement;

18 to 500 Hz @ 1 G acceleration
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Maximum altitude .................................. 2,000 m

Pollution Degree .................................... 2

Indoor use only

Safety
This product is designed to meet the requirements of the following 

standards of safety for information technology equipment:

• IEC 60950-1, EN 60950-1

• UL 60950-1, CSA 60950-1

Note For UL and other safety certifications, refer to the product label or visit 

ni.com/certification, search by model number or product line, and click the 

appropriate link in the Certification column.

Electromagnetic Compatibility
This product is designed to meet the requirements of the following 

standards of EMC for electrical equipment for measurement, control, 

and laboratory use:

• EN 55024, CISPR 24 EMC requirements

• EN 55022, CISPR 22 Emissions; Class A

• EN 55011, CISPR 11 Emissions; Class A

• CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A

Note For EMC compliance, operate this device according to product documentation.

CE Compliance
This product meets the essential requirements of applicable European 

Directives, as amended for CE marking, as follows:

• 2006/95/EC; Low-Voltage Directive (safety)

• 2004/108/EEC; Electromagnetic Compatibility Directive (EMC)

Note Refer to the Declaration of Conformity (DoC) for this product for any additional 

regulatory compliance information. To obtain the DoC for this product, visit ni.com/

certification, search by model number or product line, and click the appropriate link 

in the Certification column.
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Environmental Management
National Instruments is committed to designing and manufacturing 

products in an environmentally responsible manner. NI recognizes that 

eliminating certain hazardous substances from our products is beneficial 

not only to the environment but also to NI customers.

For additional environmental information, refer to the NI and the 

Environment Web page at ni.com/environment. This page contains the 

environmental regulations and directives with which NI complies, as well 

as any other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)
EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling 

center. For more information about WEEE recycling centers and National Instruments 

WEEE initiatives, visit ni.com/environment/weee.htm.

Mercury Disposal and Recycling
LCD lamp(s) in this monitor contain mercury. Dispose or recycle according 

to local, state or federal laws. Consult the Electronic Industries Alliance at 

www.eiae.org for more information. For specific information on lamp 

disposal, consult www.lamprecycle.org.

Cleaning
If you need to clean the unit, use a soft, nonmetallic brush. Make sure that 

the unit is completely dry and free from contaminants before returning it to 

service.

RoHS

National Instruments  (RoHS)
National Instruments RoHS ni.com/environment/rohs_china

(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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B
Watchdog Timer Programming

Windows CE includes a watchdog timer for the TPC-2106/2106T. You can 

access the timer through the WIN32 API. The TPC-2106/2106T includes 

a WDT driver, WDT1:, for enabling/disabling the watchdog timer. You 

must open this driver before using the resources, and then use the 

DeviceIOControl function to enable/disable the watchdog timer.

This appendix describes DeviceIOControl and it parameters. It also 

includes a programming example.

DeviceIOControl

DeviceIOControl sends a control code directly to a specified device driver, 

causing the corresponding device to perform the specified operation. The 

function and its parameters are:

BOOL DeviceIoControl( HANDLE hDevice, DWORD 

dwIoControlCode, LPVOID lpInBuffer, DWORD nInBufferSize, 

LPVOID lpOutBuffer, DWORD nOutBufferSize, LPDWORD 

lpBytesReturned, LPOVERLAPPED lpOverlapped );

Parameters
DeviceIOControl includes the following parameters:

• hDevice 

(in) Handle to the device that performs the operation. Call the 

CreateFile function to obtain a device handle.

• dwIoControlCode 

(in) Specifies the operation control code. This value identifies the 

specific operation to be performed and the type of device on which the 

operation is to be performed. No specific values are defined for the 

dwIoControlCode parameter. However, if you write a custom device 

driver, you can define IOCTL_XXXX control codes, per the CTL_CODE 

macro. You then can advertise these control codes, and an application 

can use these control codes with DeviceIoControl to perform 

driver-specific functions.
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• lpInBuffer 

(in) Long pointer to a buffer that contains the data required to perform 

the operation. This parameter can be NULL if the dwIoControlCode 

parameter specifies an operation that does not require input data.

• nInBufferSize 

(in) Size, in bytes, of the buffer pointed to by lpInBuffer.

• lpOutBuffer 

(out) Long pointer to a buffer that receives the operation’s output data. 

This parameter can be NULL if the dwIoControlCode parameter 

specifies an operation that does not produce output data.

• nOutBufferSize 

(in) Size, in bytes, of the buffer pointed to by lpOutBuffer.

• lpBytesReturned 

(out) Long pointer to a variable that receives the size, in bytes, 

of the data stored into the buffer pointed to by lpOutBuffer. The 

lpBytesReturned parameter cannot be NULL. Even when an 

operation produces no output data, and lpOutBuffer can be 

NULL, DeviceIoControl makes use of the variable pointed to by 

lpBytesReturned. After such an operation, the variable value has 

no meaning.

• lpOverlapped 

(in) Ignored; set to NULL.

• Return Values

Nonzero indicates success. Zero indicates failure. To get extended 

error information, call GetLastError.

How to Use the Control Codes

There are six control codes for the WDT driver operation codes.

IOCTL _WDT_ENABLE
Enables the application watchdog timer. By default, if the watchdog timer 

is enabled, the WDT driver automatically triggers itself after the specified 

period, and your application does not need to trigger the watchdog timer.

• lpInBuffer: unused

• nInBufferSize: unused
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• lpOutBuffer: unused

• nOutBufferSize: unused

IOCTL _WDT_DISABLE
Disables the application watchdog timer.

• lpInBuffer: unused

• nInBufferSize: unused

• lpOutBuffer: unused

• nOutBufferSize: unused

IOCTL_WDT_STROBE
Triggers the watchdog. If your application uses IOCTL_WDT_ENABLE 

to enable the watchdog first and then sends IOCTL_WDT_REBOOT to the 

WDT driver, your application must trigger the watchdog once during the 

watchdog timer period. If your application has not triggered at the specified 

period, the device reboots automatically.

• lpInBuffer: unused

• nInBufferSize: unused

• lpOutBuffer: unused

• nOutBufferSize: unused

IOCTL_WDT_GETTIMEOUT
Gets the watchdog time setting.

• lpInBuffer: unused

• nInBufferSize: unused

• lpOutBuffer: The DWORD pointer to your watchdog time setting. 

The watchdog time settings are:

Setting Time

0 2 s

1 (default) 5 s (default)

2 10 s

3 15 s
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• nOutBufferSize: unused

IOCTL_WDT_SETTIMEOUT
Sets the watchdog time setting.

• lpInBuffer: The DWORD pointer to your watchdog time setting. 

The watchdog time settings are:

• nInBufferSize: unused

• lpOutBuffer: unused

• nOutBufferSize: unused

IOCTL_WDT_REBOOT
If you want your application to trigger the watchdog, use 

IOCTL_WDT_REBOOT to notify the watchdog driver timer (WDT). 

Otherwise, the WDT triggers itself automatically.

• lpInBuffer: unused

• nInBufferSize: unused

• lpOutBuffer: unused

• nOutBufferSize: unused

4 30 s

Other 40 s

Setting Time

0 2 s

1 (default) 5 s (default)

2 10 s

3 15 s

4 30 s

Other 40 s

Setting Time
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Programming Example

#define WDT_CODE(ID) CTL_CODE(FILE_DEVICE_UNKNOWN,ID, METHOD_BUFFERED, 

FILE_ANY_ACCESS)

#define IOCTL_WDT_ENABLE WDT_CODE (0x900)

#define IOCTL_WDT_DISABLE WDT_CODE(0x901)

#define IOCTL_WDT_STROBE WDT_CODE(0x902)

#define IOCTL_WDT_GET_TIMEOUT WDT_CODE(0x903)

#define IOCTL_WDT_SET_TIMEOUT WDT_CODE(0x904)

#define IOCTL_WDT_REBOOT WDT_CODE(0x905)

// for compatibility reasons, you can define IOCTL as below:

// #define IOCTL_WDT_ENABLE 0x1001

// #define IOCTL_WDT_DISABLE 0x1002

// #define IOCTL_WDT_STROBE 0x1003

// #define IOCTL_WDT_GETTIMEOUT 0x1004

// #define IOCTL_WDT_SETTIMEOUT 0x1005

// #define IOCTL_WDT_REBOOT 0x1006

HANDLE m_hWDT=NULL;

TCHAR szClassName[60];

// assign the WDT driver name

wsprintf(szClassName, TEXT("WDT1:"));

// Open the WDT driver

m_hWDT = CreateFile(szClassName, GENERIC_READ GENERIC_WRITE, 0, NULL, 

OPEN_EXISTING, FILE_ATTRIBUTE_NORMAL, NULL);

if ( m_hWDT == INVALID_HANDLE_VALUE ) { DebugMsg(CString("WDT driver fail"));

return;

}

DWORD dwTemp; DWORD nIndex=2;

// Set the Watchdog Timer as 10 seconds. Number 2 means 10 seconds. 

DeviceIoControl(m_hWDT, IOCTL_WDT_SET_TIMEOUT, &nIndex, sizeof(nIndex), 

NULL, 0, &dwTemp, NULL);

// Enable the Watchdog timer

DeviceIoControl(m_hWDT, IOCTL_WDT_ENABLE, NULL, 0, NULL, 0, &dwTemp, NULL);

While (1) {

// do your job here.

Sleep(8000);

DeviceIoControl(m_hWDT, IOCTL_WDT_STROBE, NULL,0, NULL, 0, &dwTemp, NULL);

}

DeviceIoControl(m_hWDT, IOCTL_WDT_DISABLE, NULL, , NULL, 0, &dwTemp, NULL);

CloseHandle(m_hWDT);
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C
Fuse Replacement

Caution Do not replace the fuse unless it is damaged. Do not replace the fuse with a 

differently rated fuse. For more information, see the fuse specifications in Appendix A, 

Specifications.

Follow these steps to replace the fuse:

1. Remove the power cable.

2. Remove the fuse cover.

3. Replace the damaged fuse with a new one.

4. Place the fuse cover back into position.

5. Replace the power cable.
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D
Pin Assignments

RS232 Pin Assignment

Pin Number Description

Pin 1 DCD

Pin 2 Rx

Pin 3 Tx

Pin 4 DTR

Pin 5 GND

Pin 6 DSR

Pin 7 RTS

Pin 8 CTS

Pin 9 RI

1 5

96
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RS485 Pin Assignment

COM Port Setting

The TPC-2106/2106T includes three COM ports: RS232 (COM1 and 

COM2), and 4-wire RS232 (COM3) or RS485 (COM4). COM3 and COM4 

share the same DB9 connector, which you can set through the software.

Pin Number Description

Pin 1 DATA–

Pin 2 No Connection

Pin 3 No Connection

Pin 4 DATA+

Pin 5 GND

Pin 6 No Connection

Pin 7 No Connection

Pin 8 No Connection

Pin 9 No Connection

1 5

96
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E
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 

ni.com for technical support and professional services:

• Support—Online technical support resources at ni.com/support 

include the following:

– Self-Help Resources—For answers and solutions, visit the 

award-winning National Instruments Web site for software drivers 

and updates, a searchable KnowledgeBase, product manuals, 

step-by-step troubleshooting wizards, thousands of example 

programs, tutorials, application notes, instrument drivers, and 

so on.

– Free Technical Support—All registered users receive free Basic 

Service, which includes access to hundreds of Application 

Engineers worldwide in the NI Discussion Forums at 

ni.com/forums. National Instruments Application Engineers 

make sure every question receives an answer.

For information about other technical support options in your 

area, visit ni.com/services or contact your local office at 

ni.com/contact. 

• Training and Certification—Visit ni.com/training for 

self-paced training, eLearning virtual classrooms, interactive CDs, 

and Certification program information. You also can register for 

instructor-led, hands-on courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 

technical resources, or other project challenges, National Instruments 

Alliance Partner members can help. To learn more, call your local 

NI office or visit ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 

your local office or NI corporate headquarters. Phone numbers for our 

worldwide offices are listed at the front of this manual. You also can visit 

the Worldwide Offices section of ni.com/niglobal to access the branch 

office Web sites, which provide up-to-date contact information, support 

phone numbers, email addresses, and current events.
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Waste Electrical and Electronic 

Equipment compliance, A-6

storage, 1-2

support, technical, E-1

system configuration, 3-1

system font size, 3-1

system kernel specifications, A-2

system setup, 2-2

T
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touchscreen

calibration, 2-3, 3-2

specifications, A-3

TPC Configurator, 4-1, 4-4

General tab, 4-2

Misc tab, 4-2

Network tab, 4-2

watchdog, 4-2

TPC utilities, 4-1

Bright.exe, 4-4

Buzzer.exe, 4-4

Contrast.exe, 4-5

Iesample.exe, 4-5

Reboot.exe, 4-5

RegSave.exe, 4-5

Screen.exe, 4-5

soft keyboard, 4-1

tools, 4-3

ActiveSync, 4-3

NotepadPlus, 4-4

Registry Editor, 4-3

Registry Saver, 4-3

Remote Display Application, 4-4

TPC Configurator, 4-4

TPC Version Information, 4-4

TPC Configurator, 4-1

TPC Version Information, 4-4

TPC-2106/2106T

beep settings, 3-2

CE compliance specifications, A-5

cleaning specifications, 1-2, A-6

COM port setting, D-2

dimensions, A-2

display settings, 3-1

electromagnetic compatibility 

specifications, A-5

environmental management 

specifications, A-6

environmental specifications, A-4

fuse

replacement, C-1

specifications, A-4

I/O ports, 1-1

introduction, 1-1

LCD specifications, A-3

mercury disposal and recycling 

specifications, A-6

networking

via Ethernet, 4-5

via serial port, 4-6

ActiveSync setup, 4-6

host communication 

environment setup, 4-7
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